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INTRODUCTION

QUICK START
If you’re looking to get started quickly, we can help. Read this brief introduction first and
we’ll quickly move you on to the “Quick Start!” section on page 4.

THE RADIO
Congratulations on the purchase of the Icom IC-F620/F621TR series radio for yourself or
your customer. The IC-F620/F621TR is a next generation, high performance multi-
format Trunking/Conventional radio sure to fit the broad needs of analog radio
consumers.

TYPEFACE CONVENTIONS
Throughout this manual certain typeface conventions are used for greater clarity, ease of
reading and emphasis.

• Key (radio button) references are in bold.

• Programming screen references are in italics.

• Specified selections in programming screen fields are quote delimited.

THE SOFTWARE
When programming the IC-F620/F621TR series radio, ensure that you are using the
software specifically designed for the LTR/PassPort version of the IC-600 series
transceivers (the software generally included with this .pdf file) - Icom part number CS-
F620TR. This cloning software is used to retrieve, edit and write radio configuration
information to the IC-F620/F621TR. It is also used as well as to retrieve and save radio
configuration information (from or to the programming computer) for archival purposes.

SOFTWARE COMPATIBILITY
This software is compatible with Microsoft Windows 98, 98SE, ME and XP.

TRADEMARK NOTICE
Windows is a registered trademark of the Microsoft Corporation in the U.S.A. and other
countries.
PassPort is a registered trademark of the Trident Datacom Technologies Inc.
LTR is a registered trademark of the EFJ Inc.
Windows 98/Me/XP are Microsoft trademarks.

INSTALLATION
Insert the installation CD into the programming computer. Using Explorer, navigate to
the root directory of the CD. There you will find two folders “CSF620TR” (the main
programming software) and “CSF620TRADJ” (used for adjusting the radio’s RF
functionality). Select the CSF620TR folder, execute “Setup” inside of it and follow the
on-screen directions. In the section titled “User Information” you must enter the software
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product ID (provided by Icom) before continuing. Once the software is installed, you can
start it by double clicking the CS-F620TR shortcut provided on the desktop or through
the start menu (navigate to “CS-F620TR”). At this point you can also install the
adjustment software by navigating to the CSF620TRADJ folder and executing “Setup”
there. This is only needed if you intend on performing radio alignment procedures and its
functionality is not discussed in this manual.

CONNECTING RADIO
Connect the 25 pin side of the OPC-1122 Connector to the programming laptop with the
25 to 9 pin serial cable provided in the programming cable kit. Connect the microphone
connector side of the OPC-1122 into the microphone jack of the radio. Power the radio
on.

MAIN SCREEN
From this screen, you can access all the functions of the software. The screen contains
five major components: the “Main Menu,” the “Toolbar,” the “Tree Menu” (with its
“Programming Screen Icons” and folders) and the “Programming Screen”.

• The Main Menu is used to provide access to all basic program functions not
associated with radio configuration.

Main Menu
Toolbar

Programming
ScreenTree Menu

Programming
Screen Icons
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• The Toolbar provides quick access to commonly used functions.

• The Tree Menu contains various Programming Screen Icons and folders that provide
access to Programming Screens where you can read and edit detailed configuration
information.
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QUICK START!

This section is useful if you need abbreviated information on how to read, edit and write
programming information to a radio. This also serves as a useful overview of the
programming software in general.

• To access information concerning a radio (like ESN, serial number, transceiver
model, revision, comments and any installed option[s]) select  (Clone Info.) from
the Toolbar.

• To read a radio press the  (Clone Read) button on the Toolbar.

• To access configuration data stored in a file on the programming computers hard
drive, select  on the Toolbar and use the dialog box to navigate to the correct data
file (usually with a “.icf” extension).

• To start a new programming instance, select “New” from the file menu.

• To select Programming Screens go to the Tree Menu. There you will see various
Programming Screen Icons and folders (folders contain icons that are broadly
related). Single clicking on an icon displays the programming screen associated with
that icon. To open a folder either double click on it or select the “plus” sign next to it.
If the sign is a “minus,” that signifies that the selected folder is already displaying its
contents. The LTR/PassPort icon is actually folder also. If it is collapsed, expand it to
see its contents.

• Once the correct programming screen is displayed, you can view or edit parameters.
On some programming screens, the parameters scroll horizontally off to the right, so
use the horizontal scroll bar at the base of the programming screen to view and edit
those parameters.
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• To enter or view Conventional system information, select “Conv.” from the Tree
Menu (in the Memory CH folder). The “Conv.” (Conventional) programming screen
will then appear. Enter the information required.

• You must enter data in the Text field first for each line item you enter before you
enter any other information. The program will force the cursor over to the Text field
if you try and enter information anywhere else.

• As you enter information concerning the first system, note the word “New” appears
on the next line.  If you have another system you wish to enter after entering the first
one, enter it there.

• LTR and PassPort programming screens follow the same pattern as the preceding.

• Explore the other programming screens to set features as desired.

• To write to a radio press the  (Clone Write) button. Yes, the icon looks like a
handheld and we’re most definitely programming a mobile here but it’ll work fine.

• To save configuration data to a file press the  (Save) button. Use the dialog box
that to name the file and store it in the folder of your choice.

This concludes the Quick Start section.

Scroll this bar to the right to
view more parameters in this
programming screen.
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PROGRAMMING SOFTWARE IN DETAIL
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MAIN MENU

The Main Menu provides access to all basic program functions.

There are six Main Menu selections. Those selections and their sub-selections are
described as follows:

FILE MENU
Contains menu selections for operations concerning radio files, printing and quitting the
program.

File -> New: Create a new radio configuration file.

File -> Open…: Open an existing radio configuration file from the programming
computers hard drive, floppy drive, etc.

File -> Save: Save a radio configuration file to the programming computers hard drive,
floppy drive, etc.

File -> Save As…: Save a radio configuration file to the programming computers hard
drive, floppy drive, etc. under a name different from the currently open file.

File -> Print Current Sheet: Print current contents of programming screen. When selected,
a dialog box will appear. Select printer and other options from there.

File -> Print All: Print contents of all programming screens. When selected, a dialog box
will appear. Select printer and other options from there.
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File -> Recent File Section: Displays the last 4 configuration files saved or opened.

File -> Exit. Quit the program.

VIEW MENU
Contains selections for customizing aspects of the programs appearance and
functionality.

View -> Font Size: Change the displayed font size in the programming screens. Goes
from 60% to 150%. While it maybe tempting to make the font size bigger for greater
legibility, doing so also has the side effect of making fewer columns visible in the
programming screens requiring more scrolling. Find the font size for you that offers the
best compromise between legibility and amount of displayed information.

View -> Toolbar: Select to display the toolbar or not. Not displaying it achieves a small
amount more of screen real estate at the expense of ease-of-use.

COM PORT MENU
Contains selections pertaining to COM port utilization.

COM Port -> COM 1, COM 2, COM 3, COM 4: Select the one you wish to use.
Selecting a port here will automatically deselect any other selected port including
“More…”

COM Port -> More…: Manually select a COM port number between 1 and 256.
Selecting a port here will automatically deselect any other selected port.
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COM Port -> Normal: Use when radio read/write errors occur. Normal Speed is 9600
bps. Selecting this speed will automatically deselect High Speed. This is the default
selection.

COM Port -> High Speed: Use this selection unless you are having problems with radio
read/write errors. High Speed is 38400 bps. Selecting this speed will automatically
deselect Normal.

CLONE MENU
Contain selections for reading and writing to the IC-F620/F621TR series radio.

Clone -> Read <- TR: Read the configuration of a radio into the programming software.

Clone -> Write -> TR: Write the configuration of a radio from the programming software
to the radio.

Clone -> Information: Read basic information concerning the attached radio including
ESN, serial number, transceiver model, revision, comments and any installed option(s).

MODEL MENU
Allows selection amongst different radio models for the proper programming of the
attached radio.  Ensure this selection matches the radio you have connected to the
program. Currently there is only one selection here.
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Model -> LTR/PassPort: Only selection.

HELP MENU
Allows selection of help (this) document and general version and registration
information.

Help -> Contents: Select this help document.

Help -> About CS-F620TR: Displays information concerning current software version
and registration information as shown.
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TOOLBAR

The Toolbar provides quick access to commonly used functions. Note: if you let your
mouse “hover” over a Toolbar button for about one second a tool tip will be displayed,
briefly describing the function of that button.

 New Button: Create new radio configuration file.

 Open Button: Access configuration data stored in a file on the programming
computer’s hard drive. When selected, use the dialog box to navigate to the correct data
file (usually with a “.icf” extension).

 Save Button: Used to save configuration data to a file. When selected, use the dialog
box that opens to name the file and store it in the folder of your choice.

 Clone Read: Used to read configuration information in an attached radio. If you get a
“No answer from transceiver” dialog box follow the onscreen recommendations.

 Clone Write: Used to write configuration information to an attached radio. If you get
a “No answer from transceiver” dialog box follow the onscreen recommendations.

 Clone Info: Read basic information concerning the attached radio including ESN,
serial number, transceiver model, revision, comments and any installed option(s).
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TREE MENU AND PROGRAMMING SCREENS

From the Tree Menu you can select a variety of icons and folders. Selecting the
appropriate programming screen icon will display its associated programming screen to
the right. To open a folder in the Tree Menu either double click on it or select the “plus”
sign next to it. If the sign is a “minus” then that signifies that the selected folder is
already displaying its contents. Folders serve the purpose of keeping similar
programming screen icons grouped together. Collapsing a folder allows the user to de-
clutter the screen.

SPECIAL NOTES ON ALL PROGRAMMING SCREENS

THE RED “X”
  The IC-F620/F621TR programming software has a special feature that allows for

fast diagnostics of configuration issues. If there is a configuration problem in any of the
programming screens, a  will be displayed over its associated programming screen icon.
Additionally, if the programming screen that has an issue is selected, the program will
show specifically which area in the programming screen is having a problem. Look for
this when trying to diagnose configuration issues.

Tree Menu

Programming Screen

Programming
Screen Icon
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TEXT DIALOG BOX
Many programming screens use a common text entry dialog box. The purpose of this box
is to help quickly and accurately enter text that the radio will display to the end user.

You can select the text you require by simply typing in the Text Entry field. You can also
enter text by double clicking on the characters listed in the Character Selection field or by
using your arrow keys to select a character and selecting the space bar to enter the
character in the Character Selection field.

As characters are entered in the Text Entry field they are displayed in the Text Results
field much as they would actually appear to the end user on the radio’s display. Study the
text you entered into the dialog box here to ensure that the results are satisfactory.

SPACE BAR
You can use the Space Bar of computer’s keyboard to advance through data choices in
programming screen fields that have drop down selections. This is a great way to speed
up data entry.

RIGHT CLICK
You can “right click” with your mouse on all of the fields of the programming screens.
Doing so usually brings up a small menu showing you the selections you have for that
field or row.

THE WORD “SYSTEM”
The PassPort, LTR and “Conv.” (Conventional) programming screens have a number of
rows prefaced with a number from the CH column. The guide avoids the word “channel”
in referring to these and will refer to every unique entry in each row as a “system” no
matter if it is Conventional, LTR or PassPort. For example if the “Conv.” programming
screen has 5 rows filled in then there are 5 “systems” in that programming screen. If the
PassPort programming screen has 3 rows filled in then there are 3 “systems” in that
programming screen. In this case there would be a total of 8 unique “systems” in the
radio. Of course, with the Operation programming screen, any of those systems can be
assigned to a given “channel” sequence on the Right Up/Down front panel control keys.

Text Entry Field

Text Results Field

Character
Selection Field
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DEFAULTS
In many programming screens, you must generally make an entry in the Text field before
filling in other information. The defaults listed in the programming screen tables are the
defaults that you will see after this Text field has been entered.

KEY FUNCTIONS AND PROGRAMMABLE KEYS
The IC-F620/F621TR has a number of programmable keys on the radio and on the
optional HM-100TN DTMF microphone. Key Functions can be assigned to any of those
keys as described in the Key and Display Assign programming screen section starting on
page 52. In this document it assumed that when discussing something like “pressing the
Priority key” that a Priority key has been created by assigning the Priority key function
to a programmable key. That programmable key then inherits the name of the key
function.
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TREE MENU AND PROGRAMMING SCREEN DETAIL

 LTR/PassPort: Selecting this icon will display description and revision information
in the programming screen. This icon is a folder also and opening it will display the next
level of icons and folders. Don’t let the LTR/PassPort description here confuse you, you
can still add, edit and delete Conventional system information from the icons inside this
folder.
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MEMORY CH FOLDER

 Located in the main branch of the Tree Menu. This folder is used to group all
programming screen icons having to do with the configuration of each system in the IC-
F620/621TR. Use this to access and edit detailed information concerning each system in
the radio and setting system order on the channel selection buttons.
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OPERATION PROGRAMMING SCREEN

 Operation Programming Screen Icon: Icon is located in Memory CH folder. This
programming screen allows the programmer to change the particular channel a system is
programmed to, delete a system all together and also to change the text displayed on the
radio for a particular system.

Note that to delete a system, you can right click on almost any field in the programming
screen and select “Delete” from the menu that appears.  You can also reorder the channel
a system is in by right clicking on either the System Type or Text field and selecting
“Up” or “Down”. Note, you cannot add a system from here. To add a system, use the
programming screen icon of the mode you desire (also located in the Memory CH
folder).

OPERATION PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Field Description Default Suggested

Settings
CH The channel number and order of each system

in the radio.
No user entry. No user entry.

System
Type

Type of system for the current channel number.
Potential entries here would be “Conv.,”
“LTR” or “PassPort”.

No user entry. No user entry.

Text Double click here to edit a text description for
this field (as described on page 13). You can
enter up to 10 characters for this field.

Whatever was
entered in the Text
field of the
PassPort, LTR or
“Conv.”
programming
screen when the
system was
created.

Set as needed.



CS-F620TR Programming Software Manual (rev 1.0) - Memory CH Folder 18

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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PASSPORT PROGRAMMING SCREEN

 PassPort Programming Screen Icon: Icon is located in Memory CH folder. This
programming screen allows the programmer to create, read, edit and delete multiple
PassPort systems.

This programming screen has a number of entries, though in many cases the default ones
should suffice.  Note a  in the “Suggested Settings” column of the following table
indicates that this is a mandatory field. Also, you should get in the habit of entering Text
field data first.  If you try and enter data into any other field besides the Text field, the
program will re-direct the user back to the Text field automatically until data has been
entered there. Finally note that to delete a system, you can right click on almost any field
in the programming screen and select “Delete” from the menu that appears.

PASSPORT PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Field Description Default Suggested

Settings
CH The total number of lines displayed will

indicate the number of PassPort systems in the
radio. You can have many systems here; the
exact amount depends on memory available in
the radio. You will get an overflow dialog box
if you have reached the limit.

No user
entry.

No user
entry.

Remember to scroll this bar to
the right to view more parameters
in this programming screen.
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Group Field Description Default Suggested
Settings

Atr Select “Priority,” “Phone” or “Phone Off” (or
“Return” to exit without selecting a new
setting). Selecting “Priority” sets this system as
the one to be used if the Priority key is
pressed. Note: changing this field to “Priority”
will deselect any other system from being the
priority system. Selecting “Phone” sets this
system as the one to be used if the Phone
Request key is pressed. Note: changing this to
“Phone” will deselect any other system from
being the phone request system.  Select “Phone
Off” to clear this setting.

 If no
system has
been set as
a priority
system.
Otherwise:
Phone OFF
(Blank).

 Mandatory
field.
Amongst the
programming
screens for
PassPort,
LTR and
Conventional
at least one
system needs
to be set as a
priority
system even
if no Priority
key is
programmed.
Set as
needed.

Text Double click here to enter a text description for
this system (as described on page 13). You can
enter up to 10 characters for this field.

 Mandatory
field - set as
needed. You
cannot enter
any other
information
on this row
until data for
this field has
been entered.

TG Talk Group This field indicates the current number of Talk
Groups (and Select Call MINs) programmed
into this system. Also, this field can be double
clicked to open the PassPort Talk Group
Setting programming sub-screen where Talk
Group and MIN information can be edited.
Before proceeding on with the sub-screen here,
ensure that you set your Group ID Start field
correctly. For information on the Talk Group
Setting programming sub-screen, please see
that table on page 27.

0  Mandatory
field - set as
needed.

TG Dec. Pri.
TG

Select “Enable” or “Disable”. Select “Enable”
if you wish to force monitor the Primary Group
(the first group listed in the Talk Group Setting
programming sub-screen). Selecting “Enable”
here will also turn the “CH” field of the first
row of the PassPort Talk Group Setting
programming sub-screen red, indicating forced
monitor. If this set to “Enable,” it does not
matter if the radio is in scan mode or not, or
whether CH 1 (primary group) is a Scan
Member or not, the radio will always monitor
this group, even while on roam sites.

Disabled
(Blank)

Disabled
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Group Field Description Default Suggested
Settings

TG Group ID
Start

Enter from 1 to 65519. Sets the split point
where all group/alias numbers at or above this
number are considered groups and all numbers
below this number are considered MINs. This
should be set before entering the PassPort Talk
Group Setting programming sub-screen.

32000 System
operator
provided.

MIN Enter from 1 to 65519. Enter the MIN you wish
to use for this system here.

1 System
operator
provided.

ASID Enter from 1 to 127. Enter the ASID (Affiliated
System ID) for the system you wish to use
here.

1 System
operator
provided.

HSID Enter from 1 to 65535. Enter the HSID (Home
System ID) for the system you wish to use
here.

1 System
operator
provided.

Frequency
(MHz)

Home ch Enter from 1.000000 to 520.000000 (though, of
course, the radio will only function for
frequencies it is designed for). This is the home
channel of your home site and this is the
channel the radio will look to for idle messages,
go-to messages etc. (when registered to your
home system).

 Mandatory
field - system
operator
provided.

Frequency
(MHz)

Backup
Home ch

Enter from 1.000000 to 520.000000 (though, of
course, the radio will only function for
frequencies it is designed for). This is the
backup home channel that your radio will
search for and use in case of failure of the
primary home channel. This is not supported in
NTS Firmware from at least 2.4 earlier.

Blank Currently not
supported in
PassPort – do
not use.

Digital Color Code Select “0,” “1,” “2” or “3”. It is unimportant
what this is set to if Fixed DCC is set disable.

3 System
operator
provided.

Digital Fixed DCC Select “Enable” or “Disable”. When this is
enabled, the radio will only attempt to register
to sites utilizing the color code entered in the
Color Code column. This setting is primarily
used to distinguish between different systems
that utilize the same frequency (most
commonly in geographically dissimilar areas).

Disabled
(Blank)

System
operator
provided.

W/N Select “Wide” or “Narrow”. Specify if the
PassPort system you are attempting to utilize is
using wide or narrow band channels.

Wide
(Blank)

System
operator
provided.

Prefer Last-
site

Select “Enable” or “Disable”. This sets the
search behavior of the radio when it is first
turned on or a new system has been selected. If
this field is set to “Disable” the radio will
always search for its home site first. If set to
“Enable,” the radio will always search first for
the site it was registered to when the radio was
shut off or the system was changed. “Disable”
may help the PassPort system operator reduce
network traffic; “Enable” will probably ensure
quicker end-user registrations.

Disabled
(Blank)

System
operator
provided.
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Group Field Description Default Suggested
Settings

Roaming INH Select “Enable” or “Inhibit”. Selecting “INH”
will force the radio to always remain on its
home site, completely inhibiting it from
roaming. Selecting “Enable” will ensure that
the radio can roam normally.

Enable
(Blank)

Set as
needed.
Generally this
should be set
to “Enable”.

Roaming On
Strongest
Site

Select “Enable” or “Disable”. When the radio
first goes into search mode (roam), selecting
“Enable” will force the radio to search every
frequency in its immediate neighbor list
(frequencies collected from the site the radio is
currently registered to). It will then register to
the strongest site in the search (if that site meets
search [roam] criteria). “Disable” will allow the
radio, while searching, to register to the first
site it finds that meets search (roam) criteria.
Enabling this function may allow a radio to
find the best site for a given area. Disabling this
function allows the radio to discover a “good
enough” site for an area. “Disable” usually
provides quicker searches.

Disable
(Blank)

Set as
needed.
Generally this
should be set
to “Enable”.

Home
System

Look Back Select “Enable” or “Disable”. Selecting
“Enable” will force the radio to “look back” to
its home system at an interval set by the Time
field. This “look back” only occurs if the radio
is idle. If the radio “sees” the home site and it
meets search (roam) criteria, it will attempt to
register back to its home site.

Enable
(Blank)

Consult your
system
operator.
Incorrectly
setting this
may cause
unexpected
service
interruptions.

Home
System

Time Enter from 10 to 32,000 (in seconds). If the
Look Back field is set to enable, this sets
interval of time when the look back occurs.
Note: Look Back Timer will not begin until all
local neighbors are collected from the current
registered site.

60 Consult your
system
operator.
Incorrectly
setting this
may cause
unexpected
service
interruptions.
Suggested
setting for
this would be
1800. Do not
use “0”.
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Group Field Description Default Suggested
Settings

Site
Depth

Near Site Select “Null” through “5”. As the radio remains
on a PassPort site, it will collect a list of its
immediate neighbors called its “Neighbor
List”. As the IC-F620/F621TR searches, it will
remember the neighbor lists from the sites it
visits. This field sets the number of sites that
the radio will reference back to when initiating
a search. In other words, if this setting is set to
“2” then the radio will search the neighbor list
of the past two sites while in roam mode. If
each list has 5 frequencies (the limit) in them,
then the radio could potentially search 10
frequencies while roaming. These lists are
usually searched a few times before the radio
extends its search by going to “Far Sites” and
Seed Frequencies.

Null
(Blank)

Consult your
system
operator.
Given no
other
guidance
however, try
setting this at
“2” initially if
using seeds
and “5” if
not.

Site
Depth

Far Site Select “Null” through “5”. As the radio remains
on a PassPort site, it will collect a list of its
immediate neighbors called its “Neighbor
List”. As the IC-F620/F621TR searches, it will
remember the neighbor lists from the sites it
visits. This field sets the number of sites that
the radio will reference back to when initiating
a search AFTER SEARCHING NEAR SITES.
In other words, if this setting is set to “3” then
the radio will search the near sites a few times
first. Then it will go to this list and search the
neighbor list of the past three sites while in
roam mode. If each list has 5 frequencies (the
limit) in them, then the radio could potentially
search 15 frequencies while roaming. As the
radio searches “Far Sites” it also intersperses
frequencies from the Seed List (if used) to
improve the chances of finding a site.

Null
(Blank)

Consult your
system
operator. It is
recommend
that this be
set only if
you don’t use
seeds and
PassPort
Network the
radio will be
using is very
large.

RSSI
Condition

RSSI
Enable

Select “Enable” or “Disable”. If enabled, the
radio will use RSSI criteria when deciding to
attempt to register to a system. If disabled,
RSSI criteria are ignored by the radio.

Disable
(Blank)

Set as
needed.
Generally
should be
enabled.

RSSI
Condition

Min Enter from 0 to 255. This number can only be
set to the same value or less than the value in
the Preferred field so to make it less frustrating,
set the Preferred field first. This is the
minimum field strength required to remain
registered to a site. If the minimum field
strength drops below the time set by the Los
Time field, the radio will initiate looking for
another site. To cross-reference this RSSI value
to applied signal strength, please refer to the
chart on page 71.

0 Set as
needed. A
good value to
work with is
17.



CS-F620TR Programming Software Manual (rev 1.0) - PassPort Programming Screen 24

Group Field Description Default Suggested
Settings

RSSI
Condition

Preferred Enter from 0 to 255. If the number set here is
below the Min field, the Min field will be
adjusted to equal this. As a radio is looking for
a site to register to, it must see an RSSI of this
value or more before it attempts registration.
To cross-reference this RSSI value to applied
signal strength, please refer to the chart on page
71.

0 Set as
needed. A
good value to
work with is
21. Setting
this value
somewhat
higher than
the Min field
will help
prevent the
radio from
repeatedly
registering to,
and then
loosing, a
marginal site
(particularly
the one it just
left).

RSSI
Condition

Look Back Enter from 0 to 255. The Look Back field must
be enabled for this field to matter. As the radio
“looks back” at its home site, it must see an
RSSI of this value or more before it attempts
registration.

0 Set as
needed. A
good value to
work with is
35. Setting
this value
even higher
than
“Preferred”
will ensure
that the
“Look Back”
function will
work with
less
frustration for
the user.

RSSI
Condition

Los Time Enter from 0 to 255 (seconds). This is a timer
that starts as soon as received signal value has
gone below the “RSSI Minimum”. If the radio
does not see a signal at or above the “RSSI
Minimum” before the time on this timer
expires, the radio will initiate searching for
another site.

0 Set as
needed. A
good value to
work with is
20 seconds.

RSSI
Condition

Averaging Select “Enable” or “Disable”. Sets the radio to
average the received RSSI signal over 2
samples to provide more reliable signal
strength readings.

Disable
(Blank)

Set as
needed.
Generally
should be
enabled.



CS-F620TR Programming Software Manual (rev 1.0) - PassPort Programming Screen 25

Group Field Description Default Suggested
Settings

RSSI
Condition

Fringe
Areas

Select “Enable” or “Disable”. The “RSSI
Enable” field must be set to “Enable” for this
function to work. If this field is set to “Enable”
the radio works like this: if the radio initiates a
search and no systems are found that meet the
signal strength indicated in the Preferred field
(after going through the neighbor list, near and
far lists and seed lists) the radio will “switch
off” RSSI searching. It will then attempt to
register to the first site (or strongest site if the
On Strongest Site field is set to “Enable”) it
sees using low speed data only. Once it
acquires a site in that mode, it will switch RSSI
searching back on (for the next time the radio
goes into search). If set to Disable, the radio
will always use RSSI criteria when searching.

Enable
(Blank)

Consult your
system
operator,
though
generally this
should be
disabled.
Enabling this
may cause
unexpectedly
poor
transmission
quality in
certain
situations.

ASID
Black List

1 through 4 Enter from 0 to 255. Setting this prevents the
radio from attempting to register to the site
with the ASID listed here. 0 disables.

0 Consult your
system
operator
though
generally not
needed.

TOT Set to “OFF” (manually type the word in) or
enter from 0 to 255 seconds. Setting this
prevents the radio from transmitting for a
period longer than this timer.

OFF Set as
needed.

Talk
Around

Select to “None” or any of the Conventional or
LTR systems that appear in this list. This is the
system reverted to if the Talk Around key has
been pressed. If “None” is selected here and the
Talk Around key is pressed, be careful. No
useful “Talk Around” function will be enabled
and the radio may behave unexpectedly.

None
(Blank)

Consult your
system
operator.

ATB Ring
Back

Select “Enable” or “Disable”. If a user attempts
to transmit and the system is busy, enabling
this will sound a ringing tone when the system
is ready to accept traffic again.

Enable
(Blank)

Set as
needed.

Scan Block
Mode

Select “Enable” or “Disable”. When enabled,
this will cause the radio to receive all groups in
a range between the talk groups listed in the
PassPort Talk Group Setting programming sub-
screen (see page 27) under CH 2 and CH 3.
Note: Ensure that the group listed under CH 2
is numerically lower than the group in CH 3 or
this field will be marked with a  and will not
work. These groups will be scanned no matter
the setting of the Scan Member field in the
PassPort Talk Group Setting programming sub-
screen. Note: Block Mode scan will only work
when the radio is registered to its home site. If
you do not intend to use Block Mode Scan do
not assign a Scan Type key.

Disable
(Blank)

Set as
needed. Not
generally
used in
PassPort.
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Group Field Description Default Suggested
Settings

Scan Auto Group
Select

Select “Enable” or “Disable”. Selecting
“Enable” here puts the radio automatically into
group scan as this system is selected. The
groups scanned will be the groups set to “Yes”
in the Scan Member field of the PassPort Talk
Group Setting programming sub-screen (see
page 27). Even if this field is enabled, Scan can
be toggled between “Disable” and “Enable” if
the Scan key is pressed (assuming “Edit TG
List” is set to “Enabled”). Note: if Block Mode
is “Enabled” then the type of scan used (if this
field is enabled) will be “Block”. Otherwise, it
will be “Individual”.

Disable
(Blank)

Set as
needed.

Scan Edit TG
List

Select “Enable” or “Disable”. Allows user to
manually edit the groups being scanned. These
edits are normally lost if the user changes
systems or cycles power to the radio (though
not when changing groups) unless the Save TG
Scan field is enabled.

Disable
(Blank)

Set as
needed.

Scan Save TG
Scan

Select “Enable” or “Disable”. Allows user
changes to the groups being scanned to be
saved when the radio’s power is cycled or the
system is changed.

Disable
(Blank)

Set as
needed.

DTMF Decode ch Select “None” or any of the “DTMF Decode
Pri-Codes” listed. If a “DTMF Decode Pri-
Code” has been selected, the radio will emit a
ring tone and flash a “bell” icon if the proper
DTMF sequence of digits is received. You
must set up a DTMF decode entry to use this
function (see the DTMF Decode programming
screen - page 48). If the Select Call key is
pressed, the radio will also mute to dispatch
traffic until DTMF digits matching the Primary
Code or Secondary Code digit string for the
selected DTMF entry has been received.

None
(Blank)

Set as
needed.

Scrambler ON/OFF Select “OFF,” “ON” or “Inhibit”. Setting this
to “OFF” sets the scrambler off as an initial
setting. Setting this to “ON” turns the
scrambler on as an initial setting. The
Scrambler key can then be used to toggle this
function on and off. Setting this field to “Inh”
(Inhibit) will prevent the scrambler from being
used while this system is selected. See the
Scrambler Type field in the Common
programming screen (page 60) for more
information on setting up the scrambler.

OFF
(Blank)

Set as
needed.

Scrambler Code Set from 1 to 255. With the UT-109 (“Non-
Rolling” type) only the value 1 through 32 will
work. With the UT-110 (“Rolling” type) values
from 1 to 255 will work.

1 Set the code
number to
match the
code used by
the customer
in general.
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 When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).

PASSPORT TALK GROUP SETTING PROGRAMMING SUB-SCREEN
After the Group ID Start field has been set correctly, double click on the Talk Group field
in the PassPort programming screen to enter the Talk Group Setting programming sub-
screen. Don’t be confused, while this screen seems oriented around talk groups, this is
also where MINs (and their MIN aliases) can be entered to use for selective call. The
group tag you give to a MIN here will also act as a “MIN Alias” (meaning when a MIN
from a calling party matches a MIN entered here, its group tag text, rather than the MIN
number, will be displayed).

At the head of this screen is pertinent information concerning the current selected system.
Each line in this screen can be used to enter group or MIN information. Note, to delete a
row, you can right click on almost any field in the programming screen and select
“Delete” from the menu that appears.

Mode and System
Indicator

Talk Group Setting
Programming Sub-Screen

Pertinent Text and Group
Detail from Parent
Programming Screen



CS-F620TR Programming Software Manual (rev 1.0) - PassPort Programming Screen 28

PASSPORT TALK GROUP SETTING PROGRAMMING SUB-SCREEN FIELD DESCRIPTION
TABLE

Field Description Default Suggested
Settings

CH Each line can contain a new group. You can
enter up to 250 groups per PassPort system.
Don’t let the “CH” designation of this column
throw you off, each number in this column is
just a reference number and have nothing to do
with the “CH” column in the PassPort
programming screen. If you are entering a
primary group in the radio, it should be always
be the first row here, particularly if you are
enabling the Dec. Pri. TG field in the PassPort
programming screen.

No user entry. No user entry.

Group Tag Double click here to enter a text description for
this group if your Type field is going to be
“GRP” (as described on page 13). If your Type
field is going to by “MIN” (based on what you
are about to enter in “RX ID” then this tag will
become a MIN Alias tag. You can enter up to
10 characters for this field.

 Mandatory
field - set as
needed. You
cannot enter any
other information
on this row until
data for this field
has been entered.

Type This field is for reference only. Depending on
where the Group ID Start field is set and what
information is entered into the RX ID field, this
will appear as either “GRP” or “MIN”. This
field will display “GRP” when the number
entered in the RX ID field is at or greater than
the Group ID Start. When the number in the
RX ID field is less than the Group ID Start, this
field will appear as “MIN”.

No user entry No user entry

RX ID Enter from 1 to 65519. Used to enter either
group or MIN numbers. When entering groups,
enter the PassPort group number you wish for
this group entry. Your PassPort system
operator usually provides this. MINs enter here
can be used for selective call and can be
selected like any group. Also, when a MIN
from a calling party matches any of the MINs
in this column, its associated Group Tag
description, rather than the MIN number, will
be displayed.

 Mandatory
field - set as
needed.

TX ID Enter from 1 to 65519. You must enter
information into the RX ID field before
attempting to change this field. If you attempt
to enter this field first, the program will re-
direct you to RX ID field. After you enter
information in RX ID, this field will show a “<-
“ indicating that the contents of the TX ID field
is the same as the RX ID field. This field
should not be changed once its value is set to
“<-“.

 (<- After “RX
ID” field has been
entered)

 Mandatory
field – leave as set
by entry in “RX
ID” field.
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Field Description Default Suggested
Settings

Scan
Member

Select “Yes” or “No”. When Type is “GRP,”
select whether you wish the group to be
scanned by default when the radio is doing
group scan. You cannot edit this field if Type is
“MIN”.

“Yes” if “RX ID”
is a group number
otherwise “No”.

Set as needed.

When finished editing here, select “OK” to save the information entered here. Select
cancel to discard any edits.
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LTR PROGRAMMING SCREEN

 LTR Programming Screen Icon: Icon is located in “Memory CH” folder. This
programming screen allows the programmer to create, read, edit and delete multiple LTR
systems.

This programming screen has a number of entries, though in many cases the default ones
should suffice.  Note a  in the “Suggested Settings” column of the following table
indicates that this is a mandatory field. Also, you should get in the habit of entering Text
field data first.  If you try and enter data into any other field besides the Text field, the
program will re-direct the user back to the Text field automatically until data has been
entered there. Finally note that to delete a system, you can right click on almost any field
in the programming screen and select “Delete” from the menu that appears.

LTR PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Field Description Default Suggested

Settings
CH The total number of lines displayed will

indicate the number of LTR systems in the
radio. You can have many systems here; the
exact amount depends on memory available in
the radio. You will get an overflow dialog box
if you have reached the limit.

No user
entry.

No user
entry.

Remember to scroll this bar to
the right to view more parameters
in this programming screen.
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Group Field Description Default Suggested
Settings

Atr Select “Priority,” “Phone” or “Phone Off” (or
“Return” to exit without selecting a new
setting). Selecting “Priority” sets this system as
the one to be used if the Priority key is
pressed. Note: changing this field to “Priority”
will deselect any other system from being the
priority system. Selecting “Phone” sets this
system as the one to be used if the Phone
Request key is pressed. Note: changing this to
“Phone” will deselect any other system from
being the phone request system.  Select “Phone
Off” to clear this setting.

 If no
system has
been set as
a priority
system.
Otherwise:
Phone OFF
(Blank)

 Mandatory
field.
Amongst the
programming
screens for
PassPort,
LTR and
Conventional
at least one
system needs
to be set as a
priority
system even
if no Priority
key is
programmed.
Set as
needed.

Text Double click here to enter a text description for
this system (as described on page 13). You can
enter up to 10 characters for this field.

 Mandatory
field - set as
needed. You
cannot enter
any other
information
on this row
until this field
has been
filled in.

Repeater Repeater ch The number in this field indicates the row the
current home channel repeater is located on (in
the Repeater Setting programming sub-screen.
Double click here to enter the Repeater Setting
programming sub-screen (see page 34).

 Mandatory
field - set as
needed.

Repeater Set Area
Bit

Select “ON” or “OFF”. Selecting “ON” enables
the area bit. This is used primarily to
distinguish between to different systems that
may share the same frequency.

OFF
(Blank)

Set as
needed.

TG Talk Group This field indicates the current number of talk
groups programmed into this system. To set up
talk groups, double click on this field. For
information on the LTR Talk Group Setting
programming sub-screen, please see that table
on page 36.

0  Mandatory
field - set as
needed.
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Group Field Description Default Suggested
Settings

TG Dec. Pri.
TG

Select “Enable” or “Disable”. Select “Enable”
if you wish to force monitor the Primary Group
(the first group listed in the LTR Talk Group
Setting programming sub-screen). Note,
selecting “Enable” here will also turn the “CH”
field of the first row of the LTR Talk Group
Setting programming sub-screen red, indicating
forced monitor. If set to “Enable,” it does not
matter if the radio is in scan mode or not, or
whether CH 1 (primary group) is a scan
member or not, the Primary Group will still be
monitored.

TOT Set to “OFF” (manually type the word in) or
enter from 0 to 255 seconds. Setting this
prevents the radio from transmitting for a
period longer than this timer.

OFF Set as
needed.

Talk
Around

Select “None” or any of the Conventional or
LTR systems that appear in this list. This is the
system reverted to if the Talk Around key is
pressed. When “None” is selected here and the
Talk Around key is pressed, LTR simplex
operation on the home channel is allowed.

None
(Blank)

Consult your
system
operator.

ATB Ring
Back

Select “Enable” or “Disable”. If a user attempts
to transmit and the system is busy, enabling
this will sound a ringing tone when the system
is ready to accept traffic again.

Enable
(Blank)

Set as
needed.

Scan Scan
Enable

Select “Enable” or “Disable”. Selecting
“Enable” will allow this system to be scanned
when performing system scan. Selecting
“Disable” will prevent this system from being
scanned. Even if the User Edit field is set to
“Enable” the user will not be able to add this
system to the list of systems scanned (if
“Disable” is selected in this field).

Enable
(Blank)

Set as
needed.

Scan Block
Mode

Select “Enable” or “Disable”. When enabled,
this will cause the radio to receive all groups in
a range between the talk groups listed in the
LTR Talk Group Setting programming sub-
screen (see page 36) under CH 2 and CH 3.
Note: Ensure that the group listed under CH 2
is numerically lower than the group in CH 3 or
this field will be marked with a  and will not
work. These groups will be scanned no matter
the setting of the Scan Member field in the
LTR Talk Group Setting programming sub-
screen. If you do not intend to use Block Mode
do not assign a Scan Type key.

Disable
(Blank)

Set as
needed.
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Group Field Description Default Suggested
Settings

Scan Auto Group
Select

Select “Enable” or “Disable”. Selecting
“Enable” here puts the radio automatically into
group scan as this system is selected. The
groups scanned will be the groups set to “Yes”
in the Scan Member field of the LTR Talk
Group Setting programming sub-screen (see
page 36). Even if this field is enabled, Scan can
be toggled between “Disable” and “Enable” if
the Scan key is pressed (assuming the Edit TG
List field is set to “Enabled”). Note: if Block
Mode is “Enabled” then the type of scan used
(if this field is enabled) will be “Block”.
Otherwise, it will be “Individual”.

Disable
(Blank)

Set as
needed.

Scan User Edit Select “Enable” or “Disable”. Allows user to
manually add or delete this system from the list
of systems to be scanned. These edits are
normally lost if the user changes groups or
cycles power to the radio (though not when
changing groups) unless the Save User Settings
field is enabled.

Disable
(Blank)

Set as
needed.

Scan Save User
Settings

Select “Enable” or “Disable”. Allows user’s
changes to the systems being scanned to be
saved when the radio’s power is cycled or the
system is changed.

Disable
(Blank)

Set as
needed.

Scan Edit TG
List

Select “Enable” or “Disable”. Allows user to
manually edit the groups being scanned. These
edits are normally lost if the user changes
groups or cycles power to the radio (though not
when changing groups) unless the Save TG
Scan field is enabled.

Disable
(Blank)

Set as
needed.

Scan Save TG
Scan

Select “Enable” or “Disable”. Allows user’s
changes to the groups being scanned to be
saved when the radio’s power is cycled or the
system is changed.

Disable
(Blank)

Set as
needed.

DTMF Decode ch Select “None” or any of the “DTMF Decode
Pri-Codes” listed. If a “DTMF Decode Pri-
Code” has been selected, the radio will emit a
ring tone and flash a “bell” icon if the proper
DTMF sequence of digits is received. You
must set up a DTMF decode entry to use this
function (see the DTMF Decode programming
screen - page 48). If the Select Call key is
pressed, the radio will also mute to dispatch
traffic until DTMF digits matching the Primary
Code or Secondary Code digit string for the
selected DTMF entry has been received.

None
(Blank)

Set as
needed.
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Group Field Description Default Suggested
Settings

Scrambler ON/OFF Select “OFF,” “ON” or “Inhibit”. Setting this
to “OFF” sets the scrambler off as an initial
setting. Setting this to “ON” turns the
scrambler on as an initial setting. The
Scrambler key can then be used to toggle this
function on and off. Setting this field to “Inh”
(Inhibit) will prevent the scrambler from being
used while this system is selected. See the
Scrambler Type field in the Common
programming screen (page 60) for more
information on setting up the scrambler.

OFF
(Blank)

Set as
needed.

Scrambler Code Set from 1 to 255. With the UT-109 (“Non-
Rolling” type) only the value 1 through 32 will
work. With the UT-110 (“Rolling” type) values
from 1 to 255 will work.

1 Set the code
number to
match the
code used by
the customer
in general.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).

REPEATER SETTING PROGRAMMING SUB-SCREEN
 Double click on the “Repeater ch” field of the LTR programming screen to enter the
Repeater Setting programming sub-screen.

Mode and System
Indicator

Pertinent Text and Group
Detail from Parent
Programming Screen

Repeater Setting
Programming Sub-Screen
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At the head of this screen is pertinent information concerning the current selected system.
Each line in this screen can be used to enter repeater channel information. Note that to
delete a row, you can right click on almost any field in the programming screen and
select “Delete” from the menu that appears.

REPEATER SETTING PROGRAMMING SUB-SCREEN FIELD DESCRIPTION TABLE
Group Field Description Default Suggested

Settings
CH The total number of lines displayed will

indicate the number of LTR repeater channels
for the system being edited. You can enter up
to 20 repeater channels before getting an
“overflow” error.

No user
entry.

No user
entry.

Atr Select “Home Repeater” or “Return”. If you
select “Home Repeater,” then this repeater
channel will be the home repeater channel. You
can only have one home repeater channel. If
you have already selected one channel as a
home repeater, selecting another for that status
will automatically deselect the previous setting.

 Until
one of the
repeater
channel
rows is
selected as
a home
repeater.
For each
row there
after, this
field will
be blank.

 Mandatory
field for one
of the rows.
You will get
a  in each
Atr row until
you select
one of the
rows as the
home
repeater. That
will clear the

 in all
rows. Consult
your LTR
system
operator for
information
on which
repeater
channel is
“home”.

Frequency RX Enter from 1.000000 to 520.000000 (though, of
course, the radio will only function for
frequencies it is designed for). This is the radio
receive frequency for this repeater channel.

Blank System
operator
provided.

Frequency TX Enter from 1.000000 to 520.000000 (though, of
course, the radio will only function for
frequencies it is designed for). This is the radio
transmit frequency for this repeater channel.

Blank System
operator
provided.

W/N Select “Wide” or “Narrow”. Specify if the
repeater channel you are attempting to utilize is
using wide or narrow band channels.

Wide
(Blank)

System
operator
provided.

RF Pwr Set to “High” or “Low”. Specify if you wish to
transmit to this repeater channel using high or
low power.

High
(Blank)

Set as
needed.

Invert RX Data Select “On” or “Off”. Select whether or not the
radio should expect inverted RX Data.

Off (Blank) System
operator
provided.
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Group Field Description Default Suggested
Settings

Invert TX Data Select “On” or “Off”. Select whether or not the
repeater is expecting to receive inverted TX
Data.

Off (Blank) System
operator
provided.

Phone Select “On” or “Off”. Select whether or not this
repeater channel will be used for interconnect.

Off (Blank) System
operator
provided.

When finished editing here, select “OK” to save the information entered here. Select
cancel to discard any edits.

LTR TALK GROUP SETTING PROGRAMMING SUB-SCREEN
Double click on the Talk Group field of the LTR programming screen to enter the Talk
Group Setting programming sub-screen.

At the head of this screen is pertinent information concerning the current selected system.
Each line in this screen can be used to enter group information. Note that to delete a row,
you can right click on almost any field in the programming screen and select “Delete”
from the menu that appears.

LTR TALK GROUP SETTING PROGRAMMING SUB-SCREEN FIELD DESCRIPTION TABLE
Field Description Default Suggested

Settings

Mode and System
Indicator

Pertinent Text and Group
Detail from Parent
Programming Screen

Talk Group Programming
Sub-Screen
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Field Description Default Suggested
Settings

CH Each line can contain a new group. You can
enter up to 250 groups per LTR system. Don’t
let the “CH” designation of this column throw
you off, each number in this column is just a
reference number and have nothing to do with
the “CH” column in the LTR programming
screen.

No user entry. No user entry.

Group Tag Double click here to enter a text description for
this group (as described on page 13). You can
enter up to 10 characters for this field.

 Mandatory
field - set as
needed. You
cannot enter any
other information
on this row until
this field has been
entered.

RX ID Enter from 1 to 250. Set RX Group ID.  Until data is
entered in this
field.

 Mandatory
field. System
operator provided.

TX ID Enter from 1 to 250. Set TX Group ID. You
must enter information into the RX ID field
before attempting to change this field. If you
attempt to enter this field first, the program will
re-direct you to RX ID field. After you enter
information in RX ID, this field will show a “<-
“ indicating that the contents of the TX ID field
is the same as the RX ID field.  You can
change this field to be different from the “RX
ID” field for special purposes.

 Until data is
entered in the “RX
ID” field. This
field then changes
to “<-“.

 Mandatory
field – normally
leave as set after
data has been
entered in the “RX
ID” field. System
operator provided.

Scan
Member

Select “Yes” or “No”. Determines if the group
will be added to the group scan list.

Yes Set as needed.

Scan TX
Inh

Select “Yes,” “No” and “Receive Only”. When
set to “Yes,” the radio is prevented from
transmitting on this group if this group is
decoded while in group scan mode. Setting to
“No” allows full transmit and receive on this
group. Setting this to “Receive Only” makes
this group a receive only group that cannot be
transmitted on (regardless whether the user is in
scan mode or not).

No (Blank) Set as needed.

Phone Select “Yes,” “No” or “Primary Group”.
Selecting “Yes” allows this Talk Group to use
interconnect on the LTR system if the Phone
Request key is pressed. Selecting “No”
disallows the use of the Phone Request key
function. “Primary Group” selects primary
phone group.

No (Blank) Set as needed.

When finished editing here, select “OK” to save the information entered here. Select
cancel to discard any edits.
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CONV. PROGRAMMING SCREEN

 Conventional Programming Screen Icon: Icon is located in Memory CH folder.
This programming screen allows the programmer to create, read, edit and delete multiple
Conventional systems.

This programming screen has a number of entries, though in many cases the default ones
should suffice.  Note a  in the “Suggested Settings” column of the following table
indicates that this is a mandatory field. Also, you should get in the habit of entering Text
field data first.  If you try and enter data into any other field besides the Text field, the
program will re-direct the user back to the Text field automatically until data has been
entered there. Finally note that to delete a system, you can right click on almost any field
in the programming screen and select “Delete” from the menu that appears.

CONVENTIONAL PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Field Description Default Suggested

Settings
CH The total number of lines displayed will

indicate the number of Conventional systems in
the radio. You can have many systems here; the
exact amount depends on memory available in
the radio. You will get an overflow dialog box
if you have reached the limit.

No user
entry.

No user
entry.

Remember to scroll this bar to
the right to view more parameters
in this programming screen.
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Group Field Description Default Suggested
Settings

Atr Select “Priority,” “Phone” or “Phone Off” (or
“Return” to exit without selecting a new
setting). Selecting “Priority” sets this system as
the one to be used if the Priority key is
pressed. Note: changing this field to “Priority”
will deselect any other system from being the
priority system. Selecting “Phone” sets this
system as the one to be used if the Phone
Request key is pressed. Note: changing this to
“Phone” will deselect any other system from
being the phone request system.  Select “Phone
Off” to clear this setting.

 If no
system has
been set as
a priority
system.
Otherwise:
Phone OFF
(Blank)

 Mandatory
field.
Amongst the
programming
screens for
PassPort,
LTR and
Conventional
at least one
system needs
to be set as a
priority
system even
if no Priority
key is
programmed.
Set as
needed.

Frequency RX Enter from 1.000000 to 520.000000 (though, of
course, the radio will only function for
frequencies it is designed for). This is the radio
receive frequency for this channel.

 Mandatory
field - set as
needed.

Frequency TX Enter from 1.000000 to 520.000000 (though, of
course, the radio will only function for
frequencies it is designed for). This is the radio
transmit frequency for this repeater channel.

Blank Set as
needed.

W/N Select “Wide” or “Narrow”. Specify if you
wish to use wide or narrow channel width for
this system.

Wide
(Blank)

Set as
needed.
When
working with
conventional
repeaters,
consult the
system
operator.
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Group Field Description Default Suggested
Settings

C. Tone RX, TX Can be set to “DTCS” (Digital Tone Coded
Squelch), “OFF” or any number of CTCSS
selections from 67.0 to 254.1. If you select
“DTCS,” you must manually enter the Digital
Code you wish to use. Also, when entering
DTCS, enter “N” after the three digit number
for normal polarity and “I” after the three digit
number for inverse polarity (as in screen shot
that follows). Note the “023N”. See page 42 for
recommended DTCS Tones.

 

This can be used to force the radio to un-mute
only for radio traffic broadcasting the same
codes squelch signal. Also needed sometimes
to operate with Conventional repeaters.

Off (Blank) Set as
needed.
When
working with
Conventional
Repeaters,
consult the
system
operator.

Text Double click here to enter a text description for
this system (as described on page 13). You can
enter up to 10 characters for this field.

 Mandatory
field - set as
needed. You
cannot enter
any other
information
on this row
until this field
has been
filled in.

RF Pwr Select “High” or “Low”. Specify if you wish to
transmit using high or low power by default on
this system. Can be toggled with the TX Power
key.

High
(Blank)

Set as
needed.

TOT Set to “OFF” (manually type the word in) or
enter from 0 to 255 seconds. Setting this
prevents the radio from transmitting for a
period longer than this timer.

OFF Set as
needed.

Lockout Select “Busy Lockout” or “Off”. When set to
“Busy Lockout” the radio cannot transmit
while there is activity on the receive frequency
for this system.

OFF
(Blank)

Set as
needed.
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Group Field Description Default Suggested
Settings

Talk
Around

Set to “None” or any of the Conventional or
LTR systems that appear in this list. This is the
system reverted to if the Talk Around key is
pressed. When “None” is selected here and the
Talk Around key is pressed, simplex operation
is enabled. In this regard, if the TX frequency is
programmed different from the RX frequency,
simplex operation takes place on the radios RX
frequency. Also in this mode, the transmit
coded squelch is what is entered in the “C.
Tone TX” field and the coded squelch for RX
is what is entered in the “C. Tone RX” field.

None
(Blank)

Set as
needed.

RX Monitor Select “Enable” or “Disable”. Setting this field
to “Enable” allows the operator of the radio to
disable any tone coded squelch and monitor the
channel (if the Monitor key is pressed). Setting
to “Disable” prevents the user from being able
to monitor the channel, even if the Monitor
key has been toggled on.

Enable
(Blank)

Set as
needed.

Scan Scan
Enable

Set to “Enable” or “Disable”. Selecting
“Enable” will allow this system to be scanned
when performing system scan. Selecting
“Disable” will prevent this system from being
scanned. Even if the User Edit field is set to
“Enable” the user will not be able to add this
system to the list of systems scanned (if
“Disable” is selected in this field).

Enable
(Blank)

Set as
needed.

Scan User Edit Set to “Enable” or “Disable”. Allows user to
manually add or delete this system from the list
of systems to be scanned. These edits are
normally lost if the user cycles power to the
radio or changes systems unless the Save User
Settings field is enabled.

Disable
(Blank)

Set as
needed.

Scan Save User
Settings

Set to “Enable” or “Disable”. Allows user’s
changes to the systems being scanned to be
saved when the radio’s power is cycled or the
system is changed.

Disable
(Blank)

Set as
needed.

DTMF Decode ch Select “None” or any of the “DTMF Decode
Pri-Codes” listed. If a “DTMF Decode Pri-
Code” has been selected, the radio will emit a
ring tone and flash a “bell” icon if the proper
DTMF sequence of digits is received. You
must set up a DTMF decode entry to use this
function (see the DTMF Decode programming
screen - page 48). If the Select Call key is
pressed, the radio will also mute to dispatch
traffic until DTMF digits matching the Primary
Code or Secondary Code digit string for the
selected DTMF entry has been received.

None
(Blank)

Set as
needed.
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Group Field Description Default Suggested
Settings

Scrambler ON/OFF Set to “OFF,” “ON” or “Inhibit”. Setting this to
“OFF” sets the scrambler off as an initial
setting. Setting this to “ON” sets the scramble
on as an initial setting. The Scrambler key can
then be used to toggle this function on and off.
Setting it to “Inh” (Inhibit) will prevent the
scrambler from being used while this system is
selected. See the Scrambler Type and
Scrambler Group Code fields in the Common
programming screen (page 60) for more
information on setting up the scrambler.

OFF
(Blank)

Set as
needed.

Scrambler Code Set from 1 to 255. With the UT-109 (“Non-
Rolling” type) only the value 1 through 32 will
work. With the UT-110 (“Rolling” type) values
from 1 to 255 will work.

1 Set the code
number to
match the
code used by
the customer
in general.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).

RECOMMENDED DTCS CODES
023 114 174 315 445 631
025 115 205 331 464 632
026 116 223 343 465 654
031 125 226 346 466 662
032 131 243 351 503 664
043 132 244 364 506 703
047 134 245 365 516 712
051 143 251 371 532 723
054 152 261 411 546 731
065 155 263 412 565 732
071 156 265 413 606 734
072 162 271 423 612 743
073 165 306 431 624 754
074 172 311 432 627
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SEED FREQUENCY PROGRAMMING SCREEN

 Seed Frequency Programming Screen Icon: Located in the main branch of the Tree
Menu. This programming screen allows the programmer to create, read, edit and delete
seed frequencies required for any PassPort system entered. This is a global screen and all
PassPort systems will refer to this list when in search mode.

Seed frequencies in PassPort are “hard coded” search frequencies (either collect or home
channels – depending on whether the system uses redirect or not). When a radio in
PassPort mode goes into search or “roam,” normally it refers to its “neighbor list”
frequencies (or “near” or “far” neighbor frequencies) while looking for a system.
Sometimes it is more useful to hard code some frequencies in this seed list to make
likelihood of finding a system more certain, particularly on large PassPort systems with
many sites. Consult your system operator for more information on whether frequencies
are required to be entered here.  Be careful though, these frequencies are not “dynamic”
like neighbor frequencies and any change in a PassPort system home or collect channels
may require radios with those channels programmed in this list to be returned for
reprogramming.

Note that to delete a seed frequency, you can right click on the Frequency field in the
programming screen and select “Delete” from the menu that appears.

SEED FREQUENCY PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Field Description Default Suggested

Settings
No. The total number of lines displayed will

indicate the number of seed frequencies
entered. You can have a maximum of 20 before
getting an overflow error.

No user entry. No user entry.
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Field Description Default Suggested
Settings

Frequency
(MHz)

Can be set from 1.000000 to 520.000000
(though, of course, the radio will only function
for frequencies it is designed for).

Blank Set as needed.
Note: any
frequencies
programmed here
should be “home”
channels if the
PassPort system is
not setup for re-
direct and should
be collect channels
if the PassPort
system is setup for
re-direct.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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ASID TEXT PROGRAMMING SCREEN

 ASID Text Programming Screen Icon: Located in the main branch of the Tree
Menu. This programming screen allows the programmer to create, read, edit and delete
ASID text aliases required for any PassPort system entered. This is a global screen and all
PassPort systems will refer to this list when they display ASID.

This programming screen is used to alias a text name to a given ASID (for PassPort
systems). If an ASID number is to be displayed on the radio, and the received ASID
number matches an ASID in this list, the radio will display the ASID Text alias instead of
the ASID number.

Note that to delete an ASID Text alias, you can right click on almost any field in the
programming screen and select “Delete” from the menu that appears.

ASID TEXT PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Field Description Default Suggested

Settings
No. The total number of lines displayed will

indicate the number of ASID Text Aliases
entered. You can have a maximum of 10 before
getting an overflow error.

No user entry. No user entry.

ASID Can be set from 1 to 127. Blank Set as needed.
Text Double click here to enter a text description for

this ASID (as described on page 13).
Blank Set as needed.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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DTMF AUTODIAL FOLDER

 Located in the main branch of the Tree Menu. Folder used to group all programming
screen icons having to do with the DTMF encode and DTMF decode in the IC-
F620/621TR.
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DTMF ENCODE PROGRAMMING SCREEN

 DTMF ENCODE PROGRAMMING SCREEN ICON: Located in DTMF Autodial folder.
This programming screen allows the programmer to create, read, edit and delete all
global DTMF encode entries. If a Send DTMF key has been pressed, the entries from
this list appear for the operator to choose from to send the selected pre-programmed
DTMF sequence for whatever interconnect or system needs. Also these entries can be
used as auto-responses in the “Response” fields of the DTMF Decode programming
screen.

Note that to delete a row, you can right click on almost any field in the programming
screen and select “Delete” from the menu that appears.

DTMF ENCODE PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Field Description Default Suggested

Settings
No. The line number of the DTMF Encode entry.

You can have up to 10 entries here before
getting an overflow error.

No user
entry.

No user
entry.

Atr Select “Emergency” or “Emergency OFF” (or
“Return” to exit without selecting a new
setting). Selecting “Emergency” sets this
system as the one to be used if the Emergency
key has been pressed. Note: changing this field
to Emergency will deselect any other DTMF
Encode row from being the Emergency entry.
Select “Emergency OFF” to clear this setting.

Emergency
Off (Blank)

Set as
needed.

Text Double click here to enter a text description for
this entry (as described on page 13). You can
enter up to 10 characters for this field.

Blank Set as
needed.

Timer PTT Delay Enter from 0 to 32.767 (in seconds). Sets the
period of time between when the radio initiates
transmission of RF carrier and the sending the
DTMF sequence. Used to ensure the radio and
the receiving system are up and stable before
sending out the DTMF sequence.

.1 Set as
needed.
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Group Field Description Default Suggested
Settings

Timer First Digit Enter from 0 to 32.767 (in seconds). Sets
period of time in which the first digit of the
DTMF sequence will sound. Useful to provide
extra “wakeup” time for various DTMF decode
systems.

.1 Set as
needed.

Timer Special
Digit

Enter from 0 to 32.767 (in seconds). Sets
period of time in which special digits “*” (same
as “E”) and “#” (same as “F”) will sound.
These tones are often used as control codes and
it is sometimes useful to have special control
over their tone duration.

.1 Set as
needed.

Timer Digit time Enter from 0 to 32.767 (in seconds). Sets
period of time in which the each digit of the
DTMF sequence will sound (other than Special
Digit or First Digit).

.1 Set as
needed.

Timer Inter Digit Enter from 0 to .255 (in seconds). Sets period
of time between the sounding of each DTMF
digit.

.1 Set as
needed.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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DTMF DECODE PROGRAMMING SCREEN

 DTMF DECODE PROGRAMMING SCREEN ICON: Located in DTMF Autodial Folder
This programming screen allows the programmer to create, read, edit and delete all
global DTMF Decode entries.  This is a global screen and all system programming
screens will refer to this list in the “Decode ch” field.

Note that to delete a row, you can right click on almost any field in the programming
screen and select “Delete” from the menu that appears.

DTMF DECODE PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Field Description Default Suggested

Settings
No. The line number of the DTMF Decode entry.

You can have up to 10 entries here before
getting an overflow error.

No user
entry.

No user
entry.

Text Double click here to enter a text description for
this system (as described on page 13). You can
enter up to 10 characters for this field.

Blank Set as
needed.

Primary Code Enter up to 10 numbers here. This is the
sequence of DTMF digits that is the primary
decode for this row.

Blank Set as
needed.

Primary Response Select “None” or any listed entry (you must
have entries in the DTMF Encode
programming screen to see a list of selections
here). This is the DTMF response given upon
the proper decode of the digits in the Primary
Code field.

None Set as
needed.

Secondary Code Enter up to 10 numbers here. This is the
sequence of DTMF digits that is the secondary
decode for this row.

Blank Set as
needed.

Secondary Response Select “None” or any listed entry (you must
have entries in the DTMF Encode
programming screen to see a list of selections
here). This is the DTMF response given upon
the proper decode of the digits in the Secondary
Code field.

None Set as
needed.

Dead Beat Enable
Code

Enter up to 10 numbers here. This is the
sequence of DTMF digits that will restore the
radio from DTMF “stun” mode.

Blank Set as
needed.
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Group Field Description Default Suggested
Settings

Dead Beat Disable
Code

Enter up to 10 numbers here. This is the
sequence of DTMF digitals that will “stun” the
radio, causing it to become mute and unable to
transmit. Use the value in the Dead Beat Enable
Code field to reactivate the radio to normal.
Cycling the power or changing systems will not
clear the radio from “stun” mode. The radio
will display the text in the Stun Text field of
the Field Data programming screen on power
up if it is in “stun” mode.

Blank Set as
needed.

Dead Beat Response Select “None” or any listed entry (you must
have entries in the DTMF Encode
programming screen to see a list of selections
here). This is the DTMF response given upon
the proper decode of the digits in the Dead Beat
Disable Code field.

None Set as
needed.

Idle Reset Enter from .1 to 32.767 (in seconds). Time
receiver is un-muted after decode.

5.000 Set as
needed.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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COMMON FOLDER

  Located in the main branch of the Tree Menu. Folder used to group all programming
screen icons having to do with common and miscellaneous configurations used by the
radio in general.
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KEY & DISPLAY ASSIGN PROGRAMMING SCREEN

 KEY & DISPLAY ASSIGN PROGRAMMING SCREEN ICON: Located in Common folder.
This programming screen allows the programmer to assign and re-assign key functions to
programmable keys and edit miscellaneous DTMF parameters.

The preceding screen shot shows the programmable key defaults for the radio. Double
click on the field you wish to edit. The next table is a description for each row in each
group:

KEY & DISPLAY PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Row Description Default
Key P0 –P4, A, B,

C, D, *, #
A list of all programmable keys. To reassign a function
to a given key, double click on the Assign field of the
key you wish to re-assign and select from the menu that
appears. Note all key functions can be assigned to any
programmable key. Please refer to the screen and table
on page 53 for a list of all key functions that can be
assigned to programmable keys.

Refer to
previous
screen shot.

10 Key DTMF Mic Set to “Enable” or “Disable”. Selecting enable allows
for DTMF operation of the optional HM-100TN DTMF
microphone.

Disable

PTT Over Tone Set to “On” or “Off”. Selecting “On” will cause the
radio to transmit a short tone as each transmission is de-
keyed. This provides a more “affirmative” end of a
transmission to the party receiving it. This is
particularly useful for radios receiving transmissions in
noisy environments or scenarios (like PassPort selective
call) where the RF carrier from the repeater does not
drop even though the transmitting party has de-keyed.

OFF
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When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).

PROGRAMMABLE KEY FUNCTIONS

PROGRAMMABLE KEY FUNCTIONS DESCRIPTION TABLE
Key Function Description Fields and/or

Programming
Screens Related to

Null Key assigned with this has no function. NA
Send DTMF Key assigned to this function will bring up a list of DTMF

entries to select and send when activated. These entries are
listed numerically by their order of entry in the DTMF
Encode programming screen.

DTMF Encode
programming screen

Select Call This is a DTMF function only. Key assigned to this
function will toggle Select Call “On” or “Off”. When
select call is “On” the radio is muted to dispatch traffic
until a DTMF digit sequence that matches either the
primary or secondary digit sequence of the DTMF entry
selected in the “DTMF Decode ch” field for that system is
received. You must create an entry in the DTMF Decode
programming screen and select that entry in the “DTMF
Decode ch” for the desired system for this to function
properly. Note, once a DTMF selective call has been “de-
coded” the key needs to be toggled back “On” to return to
selective call mode.

See the DTMF
Decode
programming screen
and the “Decode ch”
field in the
PassPort, LTR and
Conv. programming
screens.
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Key Function Description Fields and/or
Programming
Screens Related to

Priority Key assigned to this function will cause the “Priority”
system to be selected. The purpose of this is to give the
user instant access to a critical or frequently used system.

The Atr field of the
PassPort, LTR and
“Conv.”
programming
screens. Amongst
those programming
screens, at least one
system needs to be
set as a “Priority”
even if no Priority
key is programmed.

Emergency Key assigned to this function will transmit digit sequence
of the DTMF Encode entry marked “Emergency”.

Atr field of the
DTMF Encode
programming
screen.

Scan Key assigned to this function will toggle scan between
start and stop. Note, in PassPort, group scan will only
work when registered to the home site. If the User Edit
field and/or Edit TG List field has been enabled and scan
is not active, you can select which groups or systems to
scan or not scan with the Scan key.
Select the targeted group or system, press and hold the
Scan key down until you see “SCAN ADD” or “SCAN
DEL”. This will add or delete systems or groups from
being scanned. A steady “S” icon indicates that the system
or group is in the scan list. No “S” icon indicates that it
has been removed. A blinking “S” indicates scan mode is
active.

See the PassPort,
LTR and “Conv.”
programming
screens.

Monitor Key assigned to this function will toggle the radio in and
out of Monitor mode (a “Speaker Icon” will be displayed
when mode is enabled). This disables CTCSS or DTCS
tone code squelch. Useful for monitoring frequency
activity in general without the filter of a coded squelch
inhibiting some potential receive activity.

See the “C. Tone
RX” and “C. Tone
TX” fields in the
“Conv.”
programming screen
to see if the
Conventional
system has tone
coded squelch.

Nuisance Delete While the radio is in scan, the key assigned to this function
will temporarily delete a system from being scanned. This
will not work for groups. Cycling radio power or changing
systems will clear this setting. Enabling the Save User
Setting field in the LTR or “Conv.” programming screens
will not affect this function.

NA

Scan Type Key assigned to this function toggles the scan type
between “Individual” and “Block”. If you’re not using
Block Scan, leave this unassigned.

PassPort and LTR
programming
screens.

Speed Dial Key assigned to this function will bring up a list of DTMF
entries to select and send when activated. These entries are
listed numerically by their order of entry in the DTMF
Encode programming screen.

DTMF Encode
programming screen



CS-F620TR Programming Software Manual (rev 1.0) - Key & Display Assign Programming Screen 55

Key Function Description Fields and/or
Programming
Screens Related to

Talk Around Key assigned to this function will enable the “Talk
Around” system programmed for the current system.

See Talk Around
field in the
PassPort, LTR and
“Conv.”
programming
screens.

TX Power Key assigned to this function will toggle between high and
low power. Note: this setting will only work for systems
and repeater channels whose settings are already not set to
low in their programming screens.

See RF Pwr field in
the “Conv.”
programming screen
or the Repeater
Setting
programming sub-
screen to set power
for a system or
channel high or low.

Re-dial Key assigned to this function will resend the most recently
transmitted DTMF digit sequence.

DTMF Encode
programming screen

RSSI Key assigned to this function will toggle between
displaying the RSSI of a PassPort system “On” and “Off”.
Activating this sets up an alternating display showing both
RSSI and the system or group tag. The RSSI display is in
the following format: XX YY-ZZ, where XX is the ASID
of the current system, YY is RSSI value of the current data
message and ZZ is the average RSSI value of last two
received data messages. The dash between YY and ZZ
will turn to a “+” when there is activity on the channel the
radio is monitoring.

NA

Mode Display Type Key assigned to this function will toggle the display type
between “Alpha” and “Scroll”. Select “Alpha” and the
display will show the current system or talk group. Select
“Scroll” and the display will continuously scroll detailed
information about the current PassPort, LTR or
Conventional system you have selected.

NA

Key Lock Key assigned to this function will lock the radio and
prevent further key presses from having any function.
Push and hold for 2 seconds to turn the lock function
“On”. Push and hold for 2 seconds again and enter the
pass code “1234” to toggle the lock function “Off”.  The
optional HM-100TN DTMF microphone is required for
this function and the “DTMF Mic field” in the Key &
Display Assign programming screen must be set to
“Enable”.

See the DTMF Mic
field in the Key &
Display Assign
programming
screen.

Runtime Key assigned to this function displays radios total runtime. NA
Phone request Key assigned to this function will cause the “Phone”

system to be selected. The purpose of this is give the user
instant access to the system most frequently used for
interconnect.

The Atr field of the
PassPort, LTR and
“Conv.”
programming
screens. Only one
system can be
selected as the
“Phone” system.
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Key Function Description Fields and/or
Programming
Screens Related to

Roam Request For PassPort systems only. Key assigned to this function
will force the radio to go into search mode (roam). This is
useful if the operator of the radio is having trouble with a
system (for example: distant enough to be noisy but not
weak enough to cause the radio to go into search mode)
and wishes to attempt to find a system more suitable for
his area.

NA

Site Lock For PassPort systems only. Key assigned to this function
will force the radio to remain on the current system it is
registered to, no matter the condition of low speed data or
RSSI from the system. This is useful if user will be using
the radio in a localized area where, if the radio were to go
into search mode, a better site would probably not be
found. This prevents the radio from being unnecessarily
out-of-service. Examples of where this could be handy
would be at the fringe of the only site serving an area, a
tunnel, or a localized area of blocking terrain. The radio
should be removed from Site Lock mode as soon as
possible to return to normal operation.

NA

Scrambler Key assigned to this function toggles the scrambler “On”
and “Off”.

See the Scrambler
ON/OFF and Code
fields of the
PassPort, LTR and
“Conv.”
programming
screens. Also the
Scrambler group of
fields in the
Common
programming
screen.

Battery Status Key assigned to this function toggles between display of
battery voltage and normal display. Can be useful for
troubleshooting or other special purposes, though not
normally used.

NA
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SET MODE PROGRAMMING SCREEN

 SET MODE PROGRAMMING SCREEN ICON: Located in Common folder. This
programming screen allows the programmer to edit general radio display and audio
parameters.

The preceding screen shot shows the defaults for this programming screen. Double click
on the field you wish to edit. The next table is a description for each row:

SET MODE PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Row Description Default
Backlight Select “OFF”, “Dim”, “Auto” and “ON”. Selecting “Off” disables backlight

completely. Selecting “Dim” sets backlight to be on constantly at a dim
level. Selecting “On” sets the backlight to remain on continuously. Do not
use “Auto”.

Auto

Beep Select “ON” or “OFF”. Selecting “On” will activate a short “beep” when
keys are pressed. Note: some beeps, such as the one for the lockout timer,
cannot be turned off.

ON

Beep Level Select “1” through “5” or “1 Linked” through “5 Linked”. Selecting “1”
through “5” (with “5” being the loudest) will cause the beeps to sound at a
constant volume regardless of the setting of the volume knob. Selecting “1
Linked” through “5 Linked” (with “5 Linked” again being the loudest)
“ties” the beeps to the volume control. Experiment with this setting to see
what works best for the customer.

3

SQL Level Enter a number from 0 to 255 (0 “the loosest”). Manually sets squelch
levels.

0

AF Min
Level

Enter from 0 to 255 (0 lowest). Sets the lowest level that speaker audio can
be set to. This is useful to prevent the radio operator from turning the radio
all the way down (and forgetting to turn it up) and potentially missing a call.

0
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Row Description Default
Audio Filter Select “300-3000Hz,” “0-3000Hz,” “300-3400Hz” or “0 –3400Hz”. Select

different pass characteristics for the audio filter for special purpose
applications.

300-
3000Hz

Mic Gain Select “1 Min” through “5 Max”. Increases or decreases microphone gain
for special purpose applications.

3

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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COMMON PROGRAMMING SCREEN

 COMMON PROGRAMMING SCREEN ICON: Located in Common folder. This
programming screen allows the programmer to edit miscellaneous parameters.

The preceding screen shot shows the defaults for this programming screen. Double click
on the field you wish to edit. The next table is a description for each row in each group:

COMMON PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Row Description Default
Clone
Comment

(1) & (2) These rows allow you to insert custom comments
concerning the radio. You can enter up to 16 characters in
each row. Note: You can read these comments quickly
without reading the entire contents of the radio by
hooking up the target radio to the programming computer
and selecting Clone -> Information from the main menu.

Blank

Operational
Setting

Revert on
Power UP

Select “Enable” or “Disable”. Selecting “Enable” sets the
radio to always power up to the first system in the
channel list (see Operation programming screen).
Selecting “Disable” sets the radio to always power up to
the last system selected when the radio was powered
down.

Disable

Operational
Setting

Invert TX
Data

Select “On” or “Off”. Selecting “On” inverts the polarity
of TX Data for PassPort and LTR systems. The Invert TX
Data field in the Repeater Setting programming sub-
screen will over-ride this setting.

OFF

Operational
Setting

Invert RX
Data

Selecting “On” inverts the polarity of RX Data for
PassPort and LTR systems. The Invert RX Data field in
the Repeater Setting programming sub-screen will over-
ride this setting.

OFF



CS-F620TR Programming Software Manual (rev 1.0) - Common Programming Screen 60

Group Row Description Default
Trunking
Parameters

Number of
Preamble Bits

Select “0” through “7”.  Selects number of initial bits sent
out with low speed data records to ready the decoder.
Used for both PassPort and LTR systems.

2

Trunking
Parameters

Number of
Hang Bits

Select “0” through “7”. Selects number of bits sent out at
the end of the low speed data record to aid the decoder.
Used for both PassPort and LTR systems.

2

Option TX Low
Power for all
modes

Select “Enable” or “Disable”. Selecting “Enable” forces
to radio to start in low power. The “RF Pwr” field in the
“Conv.” programming screen or the Repeater Setting
programming sub-screen over-rides this. Programming
and activating a TX Power key will over-ride this also.

Disable

Option Odometer
Write

Select “Enable” or “Disable”. Selecting “Enable” allows
certain key radio “accounting” information (such as run
time) to be periodically recorded to the radio’s memory.
To use the run time fields in the Field Data programming
screen you must enable this. Enabling this also activates
the Total Radio Runtime field in the Field Data
programming screen.

Disable

Option Display
Sequencing

Select “Enable” or “Disable”. Selecting “Enable” forces
the radio on start up to continuously scroll detailed
information about the current PassPort, LTR or
Conventional system you have selected. This can be
over-ridden by toggling the Mode Display Type key
(though if power is cycled, the display will revert to
“Scroll”).

Disable

Option PassPort
CRC LOS
Tone

Select “Enable” or “Disable”. Selecting “Enable” causes
the radio to emit a short tone whenever it goes into search
mode (roam) because CRC is not sufficient.

Disable

Option PassPort
RSSI LOS
Tone

Select “Enable” or “Disable”. Selecting “Enable” causes
the radio to emit a short tone whenever it goes into search
mode (roam) because RSSI is not sufficient.

Disable

Scrambler Type Select “Rolling” or “Non-Rolling”. The optional UT-109
(#02) or UT-110 (#02) voice scramble unit is required for
this functionality (remove the UT-108 DTMF decoder
unit to install). The UT-109 is a “Non-Rolling” type
scrambler so select “Non-Rolling” in this field if
installing a UT-109. The UT-109 will work with
Conventional, LTR or PassPort. The UT-110 is a
“Rolling” type scrambler so select “Rolling” in this field
if installing a UT-110. The UT-110 can be used with
LTR or PassPort, but only if the Synchronous Capture
field is set to “Continuous”. If the Synchronous Capture
field is set to “Standard” the scrambler can only be used
in Conventional mode.

Rolling

Scrambler Group Code Select 1 through 4. Selects group code. This setting is for
the UT-110 only as the UT-109 does not utilize group
codes.

1
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Group Row Description Default
Scrambler Synchronous

Capture
Select Standard or Continuous. This setting is for the UT-
110 only. If this is set to “Standard”, sync starts when
incoming signals are received (when squelch opens). If
this is set to “Continuous” sync is continuous. For
Conventional mode, “Standard” is recommended (though
in “Standard” the scrambler may not sync up for as long
as 4.4 seconds). For LTR or Passport, “Continuous” must
be selected here (though with Continuous mode, the radio
may experience occasional garble during voice
transmissions).

Standard

Scrambler Tone Start
Timing

Select Off, 300ms, 600ms, 1100ms. This setting is for the
UT-110 only and only if the Synchronous Capture field is
set to “Standard”. Sets the sync tone delay.

OFF

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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TIMERS PROGRAMMING SCREEN

 TIMERS PROGRAMMING SCREEN ICON: Located in Common folder. This
programming screen allows the programmer to edit all global timing parameters.

The preceding screen shot shows the defaults for this programming screen. Double click
on the field you wish to edit. The next table is a description for each row in each group:

TIMERS PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Row Description Default
Scan Delay
Timers

Resume
Delay

Enter from .1 to 25.5 seconds. When scan stops on a busy
channel and then the channel activity goes away, this is
the interval of time between when the activity goes away
and scan resumes.

2.000

Scan Delay
Timers

Group Revert Enter from 0 to 10 seconds. If the radio in group scan
stops on an active group, this is the interval of time
between when the activity goes away and the radio
reverts back to the currently selected group (for transmit
purposes). In other words this is the amount of time you
have to reply back to a scanned group. If the user does
not press the PTT in this interval of time after activity on
the scanned group has ceased, the transmission will come
up on the current group and not the scanned group.

5.000

Scan Delay
Timers

CTCSS Scan
Delay

Enter from .2 to 5 seconds. This is the interval of time
that the radio will stay on the channel during scan to
decode a CTCSS tone. If it cannot decode the proper tone
in this interval of time, scan will continue.

0.300
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Group Row Description Default
Scan Delay
Timers

DTCS Scan
Delay

Enter from 0 to 5 seconds. This is the interval of time that
the radio will stay on the channel during scan to decode a
DTCS tone. If it cannot decode the proper tone in this
interval of time, scan will continue.

0.500

Scan Delay
Timers

Conv. Turn-
off Code

Enter from 0 to .6 seconds. Sets the duration of reverse
burst after a transmission is finished. Used to quiet
squelch tails.

0.180

Scan Delay
Timers

CD Scan
Delay

Enter from 0 to 5 seconds. This is the interval of time the
radio will spend on each system looking for activity.

.090

Scan Delay
Timers

LTR Scan
Delay

Enter from .5 to 5 seconds. This is the interval of time
between when the LTR signal stops and the radio
resumes scanning.

0.600

Scan Delay
Timers

PassPort Scan
Delay

Enter from 0 to 5 seconds. This is the interval of time
between when the PassPort signal stops and the radio
resumes scanning.

1.130

Timeout
Timers
(TOT)

Dispatch TX
TOT

Set to “OFF” (manually type the word in) or enter from 0
to 255 seconds. Setting this prevents the radio from
transmitting for a period longer than this timer.

30.000

Timeout
Timers
(TOT)

Phone TX
TOT

Set to “OFF” (manually type the word in) or enter from 0
to 255 seconds. Setting this prevents the radio from
transmitting on an interconnected system for a period
longer than this timer.

180.000

Timeout
Timers
(TOT)

Time Out Pre
Alert

Enter from .1 to 18 seconds. This sets the period of time,
before the Time Out Timer expires, that the radio sounds
a TOT warning beep.

5.000

Timeout
Timers
(TOT)

Time Out
Reset Time

Enter from .1 to 18 seconds. This sets the period of time,
after the Timeout Timer has expired, that the radio is
disabled from transmitting.

0.200

Timeout
Timers
(TOT)

Odometer
Write Interval

Enter from 10 to 180 seconds. This sets the time interval
in which the radio writes “bookkeeping” (runtime etc.)
information to its internal memory.

60.000

Display
Timers

Message
Hold Time

Enter from 0 to 5 seconds. Amount of time radio
messages are displayed on screen.

2.250

Display
Timers

Scan Interval Enter from 0 to 5 seconds.  Sets scrolling interval for
radio messages.

1.500

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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TRUNKING FEATURES PROGRAMMING SCREEN

 TRUNKING FEATURES PROGRAMMING SCREEN ICON: Located in Common Folder.
This programming screen allows the programmer to edit additional trunking parameters
used by the radio.

The preceding screen shot shows the defaults for this programming screen. Double click
on the field you wish to edit. The next table is a description for each row in each group:

TRUNKING FEATURES PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Row Description Default Suggested

Settings
PassPort
Features

Handshake
Melody

Select from various radios tones in menu.
This is the tone used for each transmission
when handshaking with a PassPort system.

PassPort
Handshake

PassPort
Handshake

PassPort
Features

Handshake
Retry Limit

Enter from 0 to 255. This is the number of
times a handshake will be attempted with a
PassPort system until a “Busy” tone is
emitted from the radio. The user at this
point needs to release the PTT key and try
again.

6 5

PassPort
Features

Handshake
ACK Wait
Time

Enter from .25 to 65.535. This is the amount
of time the radio will wait for a handshake
acknowledge.

0.690 0.690

PassPort
Features

Fade Time Enter from 0 to 7.5. This is the amount of
time the receiver will continue to monitor
the current channel in the event the channel
fades.

2.000 2.000
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Group Row Description Default Suggested
Settings

PassPort
Features

Reacquire
Time

Enter from 0 to 250. If a PassPort radio
goes into search (roam) mode and it
attempts to go back to the same site it left, it
will not attempt to register to the site
(because it probably does not need to)
unless this period of time has elapsed.

90.000 90.000

PassPort
Features

Selective Call
Wait Time

Enter from 10 to 30. This is the amount of
time the radio will wait for a successful
selective call to be setup by the system after
the radio initiates a selective call.

20.000 30

Other Time Loss of
Carrier Roam
Start

Enter from 2 to 250. This is the amount of
time between when radio has lost low speed
data from the PassPort system that it is
currently registered to and when it will go
into search (roam) mode.

30.000 20

Other Time Select System
Roam Delay

Enter from 2 to 250. After a new system is
selected, this is the amount of time the radio
will wait until initiating search (roam)
mode.

11.000 7

Other Time Roaming
Wait

Select from 2 to 65.535. If a radio is in
search (roam) mode, this is the amount of
time the radio will wait on each frequency
for PassPort data activity before moving on
to the next frequency in its neighbor lists or
seed list.

5.500 This setting
should be set
to about 2.5
times the idle
message
interval of the
PassPort
system. For
example, if
the system is
setup to send
out an idle
message
every 2
seconds, then
the suggested
setting here
would be “5”.

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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FIELD DATA PROGRAMMING SCREEN

 FIELD DATA PROGRAMMING SCREEN ICON: Located in Common Folder. This
programming screen allows the programmer to edit miscellaneous expert and other
parameters.

The preceding screen shot shows the defaults for this programming screen. Double click
on the field you wish to edit. The next table is a description for each row in each group:

FIELD DATA PROGRAMMING SCREEN FIELD DESCRIPTION TABLE
Group Row Description Default
Text Opening Text Double click here (as described on page 13) and enter the

text you wish to have displayed when the radio is first
powered on. You can enter up to 10 characters here.

HELLO

Text Stun Text Double click here (as described on page 13) and enter the
text you wish to have displayed if the radio has been
stunned (PassPort or DTMF stun). You can enter up to 10
characters here.

STUNNED

Text Kill Text Double click here (as described on page 13) and enter the
text you wish to have displayed if the radio has been
killed (PassPort only). You can enter up to 10 characters
here.

KILLED

Expert Reset Melody Select from various radios tones in the menu. This is the
tone used when the radio is powered on or reset.

Register

Expert Run Time
Limit Enable

Select Enable or Disable. Selecting “Enable” here allows
access to the “Run Time Limit (day:Hour:Min)” field and
also ensures that the radio will not function beyond the
time listed in the Run Time Limit field.

Disable
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Group Row Description Default
Expert Run Time

Limit
(Day:Hour:M
in)

Enter from 0:00:00 to 999:23:59. To access this field you
must set the Run Time Limit Enable field to “Enable”.
Enter the amount of days, hours and minutes you wish to
have to radio function for.

99:23:59

Expert Total Radio
Runtime

Displays the cumulative runtime for the radio for the
period of time that the Odometer Write field of the
Common programming screen has been set to “Enable”.

0:00:00. No
user entry.

Expert Field Serial
Number

Enter from 00000000 to 99999999. A user-defined serial
number can be entered here.

00000000

Ignition
SW

Disable Select “Enable” or “Disable”. Selecting “Enable” here
will set the radio to power on automatically when the
ignition switch is turned on.

Disable

When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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CHARACTER EDITOR PROGRAMMING SCREEN

 CHARACTER EDITOR PROGRAMMING SCREEN ICON: Located in Common Folder.
This programming screen allows the programmer to create custom display characters.

You can create and enter custom characters in the 16 fields here. These characters can be
used, along with the default characters, as the text to enter in the Text Dialog Box (see
page 13).

To create or edit a custom character, double click on one of the 16 new or existing fields
in the Character Editor programming screen.

A dialog box will then be displayed that will allow you to edit segments. Click on the
segments in this screen (to toggle the segment on or off) to create the character of your
choice. Press OK when finished or Cancel to discard any edits.
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When done editing in this programming screen you can proceed to other programming
screens, save your programming parameters to a file or proceed to writing the
information to the radio (assuming that editing has been finished for all other required
programming screens also).
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Appendix
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APPENDIX A - RSSI Reference Chart (for “Min” and “Preferred”
fields in the PassPort Programming Screen)
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APPENDIX B - Suggested Radio Setups

The following are suggested setups for various system scenarios. The IC-F620/F621TR
series radio is highly versatile and is capable of far more functions than indicated here.
None-the-less, the demonstrated configurations are a good starting point for configuring
the radio for a variety of system protocols. These can be a starting point for configuring a
radio for each customer’s or system operator’s needs.



CS-F620TR Programming Software Manual (rev 1.0) - PassPort 73

PASSPORT

This is a suggested setup and function description for a radio that will be primarily used
on a PassPort system.

Refer to the next table for a description of what these keys do.

KEY ASSIGNMENTS AND FUNCTIONS
Keys Key

Assignment
Function

Group/MIN
Up/Down

N/A Use this to scroll through the group list. The group list may also
contain a list of MINs for selective call. A double beep will sound as
you reach the “limit” and cycle to the “top” or “bottom” of the list.

P0 Site Lock This will force the radio to remain “Locked On” the current site, no
matter the quality of signal from that site. This is useful if the radio is
using a marginal site but if the radio were to go into search mode, a
better site would probably not be found. This prevents the radio from
being unnecessarily out-of-service. Examples of where this could be
handy would be at the fringe of the only site serving an area, a tunnel,
or a localized area of blocking terrain. The radio should be removed
from Site Lock mode as soon as possible to return to normal operation.

P1 Roam Request This will force the radio to go into search mode (roam). This is useful
if the operator of the radio is having trouble with a system (for
example: distant enough to be noisy but not weak enough to cause the
radio to go into search mode) and wishes to attempt to find a system
more suitable for his area.

P2 Talk Around If the radio has a Conventional or LTR system programmed into it, this
key would be used to quickly switch to that system for localized or
other use.

P3 Mode Display
Type

This mode provides useful information concerning the system and site
the radio is currently registered to. Particularly useful when attempting
to troubleshoot problems a user may be experiencing in the field with a
PassPort system.

P0: Site Lock
P4: RSSI

P1: Roam Request
P3: Mode Display Type

P2: Talk Around

Group/MIN Up/Down System Up/Down
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Keys Key
Assignment

Function

P4 RSSI The Signal Strength Indicator on the Function Display usually shows
sufficient information concerning the strength of the signal from the
site the radio is currently registered to. There are times, often when
attempting to troubleshoot system problems, that selecting this will
provide more detailed information concerning the signal strength (and
the ASID of the current system). Also, advanced users often appreciate
the information displayed here. Activating this key sets up an
alternating display between the RSSI and the system or group tag
(depending on which rocker key, System or Talk Group, was last
activated). The RSSI display is in the follow format: XX YY-ZZ,
where XX is the ASID of the current system, YY is RSSI value of the
current data message and ZZ is the average RSSI value of last two
received data messages. The dash between YY and ZZ will turn to a
“+” when there is activity on the channel the radio is monitoring.

System
Up/Down

N/A Use this to scroll through the system list. A double beep will sound as
you reach the “limit” and cycle to the “top” or “bottom” of the list.

TYPICAL FUNCTIONS AND CONDITIONS
Function How to Use
Power On When the radio is first activated, it will briefly display the text entered in the

Opening Text field of the Field Data programming screen. Then is will display the
firmware version. It will then begin to look for a system to register to. Depending on
the setting of the Preferred Last Registered field of the PassPort programming
screen, the radio will first search for its “Home Site” or the site it was last registered
to.

Searching (Roam) The radio go into search mode when one of several criteria are met:
• When the radio has just been turned on.
• When a new PassPort system is selected.
• When the signal from the current site the radio is registered to becomes

unusable for communications.
• When the Roam Request key is activated.

Normally, a site should be found within about 20 seconds. On large systems or in
marginal conditions this process could take up to 10 minutes or longer.
While in search mode the radio will display “NO SVC” alternating with the current
group or system tag. When a better site has been located the radio will attempt to
register.

Registration You will see the ASID (or ASID alias) of the site the radio is attempting to register
to on the Function Display. When the radio has successfully registered, the
registration tone will sound.

System Up/Down
Keys and
Group/MIN
Up/Down Keys

The current System can be displayed by pressing either of the System Up/Down
keys. Another press of either key will change the system (if there is more than one
system in the radio). The current group can be displayed by pressing either of the
Group/MIN Up/Down keys. Another press of either key will change the group (if
there is more than one group in the system) or select MIN aliases for selective call
(again – if so programmed). When changing groups, if the radio is registered to its
“home site”, the radio will NOT need to “re-register” into the site as a new group is
selected. The user should not expect registration tones except when first registering
to the site. If a user is on a “roam site” the user must wait for the radio to register to
the site again (and get the registration tones) as a new group is selected (though not
technically true if the group selected is a “primary group”).
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Function How to Use
Group Dispatch After the radio has registered, it is normally ready to perform “Group Dispatch”. To

call a base unit or other field units, simply press the PTT key. Wait until you get the
PTT “handshake” tone and then start speaking. It is a common mistake for first time
users to attempt to “over talk” this tone (particularly as there is a slightly longer
delay to get this tone than in other protocols like LTR), but after a couple of minutes
of practice the user should have no further difficulties. In Group Dispatch mode, all
users registered to a particular group will hear any unit transmitting on that group.

Selective Call Selective call can be accomplished by selecting a selective call “MIN alias” with the
Group/MIN Up/Down keys. After selecting the MIN Alias, press the PTT key. If
the other unit is available, you should receive a response in about 5 seconds though
on very large system it could take up to 30 seconds. If the selective call does not go
through, you will hear a low tone and the display will remain on the MIN Alias.  If it
does go through you will hear a tone and be connected. You can now have a private
conversation with the person you are connected to without disturbing any dispatch
group. To disconnect a selective call, press the Group/MIN Up key. You will hear a
disconnect tone. Note, when using selective call, the site’s repeater that was setup
for the selective call will stay up for the duration of the call. This can be slightly
disconcerting for users used to group dispatch as the radio does not behave as it does
during a dispatch call (where the channel drops when the sending party quits
transmitting). A way to help confirm when the other party has stopped transmitting
is to enable the PTT Over Tone field of the Key and Display Assign programming
screen (see page 52).

Scan In the recommended settings, a Scan key is not setup. This is because, at this time,
scan capabilities are limited in PassPort. You cannot scan across systems and group
scan will only work if the radio is registered to its “home site” (unless “scanning”
the “primary group”). Also, since the ability to roam is one of the primary
advantages of PassPort, there may be some user confusion when attempting to
understand when scanning will work and when it will not. If the radio will only be
used on a “home site” this suggestion can be disregarded and the P4 key would
make a good candidate as a Scan key.
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LTR TRUNKING

This is the recommended setup and function description for a radio that will be primarily
used on a LTR system.

Refer to the next table for a description of what these keys do.

KEY ASSIGNMENTS AND FUNCTIONS
Keys Key

Assignment
Function

Group
Up/Down

N/A Use this to scroll through the group list. A double beep will sound as
you reach the “limit” and cycle to the “top” or “bottom” of the list.

P0 Scan Use this to key to enable scan mode and also to edit systems or groups
to be scanned (if allowed for the system in use – see the User Edit or
Edit TG List fields in the LTR programming screen).
To enable group scan, press either of the Group Up/Down keys and
then enable scan with this key. To enable system scan, press either of
the System Up/Down keys and then enable scan with this key.
The Scan key is also used to toggle whether a group or system is
scanned. If User Edit and/or Edit TG List has been enabled for a
system and the system is not in scan mode, you can select which
groups or systems to scan or not scan. Select the targeted group or
system, press and hold the Scan key down until you see “SCAN ADD”
or “SCAN DEL”. This adds or deletes the system or group from being
scanned. A steady “S” icon indicates that the system or group is in the
scan list. No “S” icon indicates that it has been removed. A blinking
“S” indicates scan mode is active.

P1 Nuisance
Delete

This is useful to temporarily remove non-essential systems from being
scanned. This will not work for groups. Cycling radio power or
changing systems will clear this setting.

P2 Talk Around If the radio has a Conventional or another LTR system programmed
into it, this key would be used to quickly switch to that system for
localized or other use.

P3 Mode Display
Type

This mode provides useful information concerning the system the radio
is currently using. Particularly useful when attempting to troubleshoot
problems a user may be experiencing in the field with an LTR system.

P4 Custom Set aside for custom use such as for a Phone or Priority key.
System
Up/Down

N/A Use this to scroll through the system list. A double beep will sound as
you reach the “limit” and cycle to the “top” or “bottom” of the list.

P0: Scan
P4: Custom

P1: Nuisance Delete
P3: Mode Display Type

P2: Talk Around

Group Up/Down System Up/Down
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TYPICAL FUNCTIONS AND CONDITIONS
Function How to Use
Power On When the radio is first activated, it will briefly display the text entered in the

Opening Text field of the Field Data programming screen. It will then show the
firmware version.

System Up/Down
Keys and
Group/MIN
Up/Down Keys

The current System can be displayed by pressing either of the System Up/Down
keys. Another press of either key will change the system (if there is more than one
system in the radio). The current group can be displayed by pressing either of the
Group Up/Down keys. Another press of either key will change the group (if there is
more than one group in the system).

Group Dispatch After the radio has registered, it is normally ready to perform “Group Dispatch”. To
call a base unit or other field units, simply press the PTT key. Wait until you get the
PTT “handshake” tone and then start speaking. It is a common mistake for first time
users to attempt to “over talk” this tone, but after a couple of minutes of practice the
user should have no further difficulties. In Group Dispatch mode, all users registered
to a particular group will hear any unit transmitting on that group.

Scan For a detailed description of how to use the scan function, refer to the P0 key
description in the previous table. Remember, many scan functions can be enabled or
prohibited or set to a default on a system-by-system basis. Refer to the fields in the
Scan group in the LTR programming screen.
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CONVENTIONAL

This is the recommended setup and function description for a radio that will be primarily
used in Conventional mode.

KEY ASSIGNMENTS AND FUNCTIONS
Keys Key

Assignment
Function

P0 Scan Use this to key to enable scan mode and also to edit systems to be
scanned (if allowed for the system in use – see the User Edit field in
the “Conv.” programming screen). Use this key to enable or disable
the radio’s system scan function.
The Scan key is also used to toggle whether a system is scanned. If the
User Edit field in the “Conv.” programming screen has been enabled
for a system and the system is not in scan mode, you can select which
systems to scan or not scan. Select the targeted system, press and hold
the Scan key down until you see “SCAN ADD” or “SCAN DEL”.
This adds or deletes the system from being scanned. A steady “S” icon
indicates that the system is in the scan list. No “S” icon indicates that it
has been removed. A blinking “S” indicates scan mode is active.

P1 Nuisance
Delete

This is useful to temporarily remove non-essential systems from being
scanned. Cycling radio power or changing systems will clear this
setting.

P2 Talk Around If the radio has another Conventional or LTR system programmed into
it, this key would be used to quickly switch to that system for localized
or other use.

P3 Custom Set aside for custom use such as for a Phone or Priority key.
P4 Monitor Use this to toggle the radio in and out of Monitor mode (a “Speaker

Icon” will be displayed when mode is enabled). This disables CTCSS
or DTCS tone code squelch. This is useful for monitoring frequency
activity by bypassing any active coded squelch.

System
Up/Down

N/A Use this to scroll through the system list. A double beep will sound as
you reach the “limit” and cycle to the “top” or “bottom” of the list.

P0: Scan
P4: Monitor

P1: Nuisance Delete
P3: Custom

P2: Talk Around

No Function System Up/Down



CS-F620TR Programming Software Manual (rev 1.0) - Conventional 79

TYPICAL FUNCTIONS AND CONDITIONS
Function How to Use
Power On When the radio is first activated, it will briefly display the text entered in the

Opening Text field of the Field Data programming screen. It will then show the
firmware version.

System Up/Down
Keys

The current system can be displayed by pressing either of System Up/Down keys.
Another press of either key will change the system (if there is more than one system
in the radio).

Simplex Use Press the Push to Talk key to broadcast to one or more radios on the same
frequency and using the same tone coded squelch (if utilized).

Use with a
Repeater

If coded squelch is used on a repeater, briefly press the Monitor key ensure that no
one else is currently using the repeater (the Monitor key disables the “coded
squelch” – enabling the user to hear all activity on the channel). Then press the Push
to Talk key to broadcast to other users on the same repeater system utilizing the
same coded squelch.

Scan For a detailed description of how to use the scan function, refer to the P0 key
description in the previous table. Remember, many scan functions can be enabled or
prohibited on a system-by-system basis. Refer to the fields in the Scan group in the
“Conv.” programming screen.


